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Abstract: This research extends the foundational study “Enhancing Railway Accident Prevention Using Deep Learning, 

Machine Learning, and GPS Tracking” (Vikas Chandra Giri & Parineeta Jha, 2025). The present work introduces an 

adaptive framework that integrates Deep Learning (DL), Internet of Things (IoT) sensor networks, and real-time GPS 

analytics to advance predictive railway safety. With results Sets in these volume.The architecture enhances detection 

accuracy, reduces response latency, and improves contextual awareness using hybrid CNN–LSTM–Random Forest 

fusion models with a multi-layer IoT sensing infrastructure. The model achieves 97.8% accuracy and maintains average 

GPS latency under 4 seconds, marking a significant improvement over earlier implementations.Through continuous 

learning and edge-cloud synchronization, the system advances toward fully autonomous accident prevention, predictive 

maintenance, and real-time operational intelligence across railway networks. 
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I.     INTRODUCTION 

 

Railways form the backbone of national and global transport systems, carrying billions of passengers and tons of freight 

annually. Despite modernization, accidents caused by human error, equipment failure, and environmental factors remain 

frequent.The earlier study by  (Vikas Chandra Giri & Parineeta Jha, 2025). combined Deep Learning (DL), Machine 

Learning (ML), and GPS tracking to build an intelligent, data-driven accident prevention model. Although results were 

promising, limitations in latency, dataset diversity, and contextual awareness restricted deployment at scale.This paper 

presents a continuation of that research, introducing IoT-integrated adaptive Deep Learning and real-time GPS analytics. 

The goal is a cloud-synchronized, self-learning safety framework capable of real-time anomaly detection and pred- ictive 

alert generation across large rail networks.   

 

C. Global Railway Accident Trend (2015–2025) 

Year Estimated Incidents 

2015 13,500 

2016 13,000 

2017 12,800 

2018 12,500 

2019 12,200 

2020 11,800 

2021 11,500 
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C. Global Railway Accident Trend (2015–2025) 

Year Estimated Incidents 

2022 11,300 

2023 11,200 

2024 11,000 

2025 (Projected) 10,700 

 

Figure 7: Global Railway Accident Trend (2015–2025) 

 

II.     BACKGROUND AND RELATED WORK  

 

Earlier contributions include:  

• Patil (2017): Image-based crack detection on railway tracks.  

• Hadj-Mabrouk (2020): ML-based accident prediction from historical records.  

• Wang (2021): Deep residual networks for video-based anomaly detection.  

• Zhang (2022): CNN for trespassing detection using CCTV footage.  

 

Modern research: Recent studies by Sarp, Kuzlu, and Guler (2024) on AI-powered digital twin trains and Mishra & 

Kumar (2024) on IoT-driven smart railways show potential for real-time safety monitoring. Yet, issues like latency, 

sensor calibration, and cross-platform integration remain barriers. 

**Processing → ML → DL → IoT Fusion → Digital Twin) 

 

The integration of advanced technologies such as Machine Learning (ML), Deep Learning (DL), Internet of Things 

(IoT), and Digital Twin is transforming various industries by enabling more efficient and intelligent systems. These 

technologies are often combined to create innovative solutions that enhance operational capabilities, improve predictive 

maintenance, and facilitate real-time data analysis.Machine Learning (ML) serves as the foundation for developing 

algorithms that can learn from data, identify patterns, and make decisions with minimal human intervention. Deep 

Learning (DL), a subset of ML, utilizes neural networks with multiple layers to process complex data such as images, 

speech, and sensor information, leading to more accurate and sophisticated models.The Internet of Things (IoT) connects 

physical devices, sensors, and systems to collect and exchange data across networks. This connectivity enables real-time 

monitoring, automation, and data-driven decision-making, which are critical for optimizing processes and resource 

management.The Digital Twin concept involves creating a virtual replica of physical assets, processes, or systems. This 

digital representation allows for simulation, analysis, and optimization without impacting the actual environment. Digital 

Twins are instrumental in predictive maintenance, system testing, and scenario planning, providing valuable insights that 

improve efficiency and reduce costs.When these technologies are integrated, organizations can leverage the strengths of 

each to develop comprehensive solutions. For example, IoT devices collect real-time data, which is processed by ML 

and DL algorithms to predict failures or optimize performance.  

 

III.    PROBLEM STATEMENT 

 

⚫ Analyze historical accident data to identify recurring patterns 

⚫ Monitor real-time train locations using GPS technology 

⚫ Predict and respond to anomalies using advanced ML and DL models 

=> Limited dataset diversity  

=> Independent ML and DL pipelines 

=> High average alert latency  

=> Lack of environmental and contextual data 

An enhanced, multi-modal AI–IoT–GPS system with ≥97% accuracy capable of real-time railway accident detection 

and prevention. 
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IV.      SYSTEM ARCHITECTURE AND METHODOLOGY 

 

The system follows a four-layer adaptive architecture: 

 

A. Sensing Layer 

IoT sensors: vibration, pressure, temperature, ultrasonic, and image capture. 

GPS modules: provide spatial and velocity data at 0.5 s intervals. 

 

B. Processing Layer 

CNN for visual anomaly detection. 

LSTM for temporal sensor pattern learning. 

Random Forest for final decision smoothing and fusion. 

 

C. Communication Layer 

Uses MQTT protocol for low-latency data transmission. 

Redundant 4G/5G links ensure continuous operation. 

 

D. Decision Layer 

 

Data displayed on a Grafana dashboard. 

Multi-level alerts: Safe, Caution, Warning, and Critical. 

 

V.    DATA ACQUISITION AND PREPROCESSING 

 

Data sources: 

 

• Indian Railways public safety data. 

• European railway datasets. 

• Simulated IoT readings (vibration, pressure, weather). 

• GPS position logs (train coordinates, speed, timestamp). 

 

Preprocessing: 

 

• Normalization and encoding of mixed data types. 

• KNN imputation for missing values. 

• Video frames resized to 128×128 pixels. 

• Data augmentation using noise and brightness adjustment. 

 

Raw Data → Cleaning → Feature Extraction → Normalization → Augmentation → Model Input 

 

VI.      MODEL DESIGN 

 

A. CNN Module 

Three convolutional layers (32, 64, 128 filters), max pooling, and dense output for binary classification. 

 

B. LSTM Module 

128 units, 30-timestep window sequence learning. 

 

C. Random Forest Fusion 

200 trees aggregate model confidence scores. 

 

Fusion formula: R = 0.4P_CNN + 0.35P_LSTM + 0.25P_RF 

If R > 0.75, a Critical Alert is triggered. 
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VII.   METHODOLOGY AND IMPLEMENTATION 

 

Edge Devices: Raspberry Pi 4 (8 GB RAM) with TensorFlow Lite. 

Cloud GPU: NVIDIA RTX 3060 Ti (8 GB). 

Languages/Frameworks: Python 3.11, TensorFlow, Scikit-learn, OpenCV. 

Database: PostgreSQL   for structured and time-series data. Or MongoDB  

Visualization: Grafana + Plotly dashboards. 

All data transmissions are encrypted using AES-256, ensuring cybersecurity compliance. 

 

Experimental Evaluation 

  Input Features (X) and Target Labels (y) 

 

Each instance of data used for prediction includes the following features: 

 

Input Features (X): 

• Speed: Real-time train speed, compared to zone-specific safety limits 

• GPS Coordinates: Latitude and longitude, used to map the train's exact location 

• Time: Timestamp of the reading, useful for correlating patterns (e.g., night-time risks) 

• Zone ID and Track ID: Encoded identifiers for each railway segment, indicating risk-prone     

   areas 

• Weather Conditions: Rain, fog, or heatwave indicators, which can impact braking and  

   visibility 

• Sensor Inputs: 

  o Track defect sensors 

  o Signal strength monitors 

  o Obstacle detection cameras 

• Historical Flags: Whether the location has had prior accidents or maintenance issues 

 

Target Labels (y): 

• Binary Classification: 

  o 0 = No Accident Risk 

  o 1 = Accident Risk Detected 

 

• Multi-Class Classification (for risk type): 

  o 0 = Safe 

  o 1 = Signal Failure 

  o 2 = Track Obstruction 

  o 3 = Overspeeding 

  o 4 = Unauthorized Access, etc. 

 

[GPS (Coordinates) + Speed + Zone ID + Sensors + Weather] => [Feature Vector] => [Trained Model] 

↓ ↓ 

[Real-time prediction => Risk Score = 84%] 

↓ 

[Trigger CRITICAL Alert] 

 

VIII.     RESULTS AND PERFORMANCE EVALUATION 

 

Model Accuracy (%) Precision Recall F1 ROC-AUC 

Random Forest 94.3 0.92 0.91 0.915 0.94 

CNN 96.1 0.94 0.93 0.935 0.96 

LSTM 95.5 0.93 0.92 0.925 0.95 

CNN + LSTM Fusion 97.8 0.96 0.95 0.955 0.98 
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B. Latency Evaluation 

Network Type Mean Latency (s) 95th Percentile (s) Packet Loss (%) 

3G 5.7 9.2 2.4 

4G 3.9 6.1 1.1 

5G 2.8 4.4 0.4 

Figure 6: Network Latency Distribution Graph ) 

 

VIII.A Machine Learning Perspective 

This perspective focuses on the predictive modeling and pattern recognition capabilities of traditional Machine Learning 

(ML) algorithms such as Random Forests, Decision Trees, and Support Vector Machines (SVMs). ML models were 

primarily used for structured data—speed, GPS coordinates, track conditions, and environmental parameters—to detect 

abnormal operational patterns. They provided interpretable and computationally efficient baseline models for early-stage 

anomaly detection, helping the system establish decision thresholds and perform probabilistic risk classification before 

deeper neural analysis.  

 

 

VIII.B Deep Learning Perspective 

From a Deep Learning (DL) standpoint, the system leveraged Convolutional Neural Networks (CNNs) for spatial feature 

extraction from railway imagery and Long Short-Term Memory (LSTM) networks for temporal sequence learning. This 

hybrid CNN–LSTM fusion allowed the model to perceive both *where* and *when* anomalies occur, enhancing 

contextual awareness and decision accuracy. DL’s ability to automatically learn hierarchical features from large datasets 

led to a 3–4% accuracy improvement over classical ML models. Together with IoT sensor fusion and GPS telemetry, 

DL forms the cognitive core of the Autonomous predictive frame work.  

 

IX.    DISCUSSION 

 

The CNN–LSTM fusion model provides high precision and recall through complementary learning: 

• CNN focuses on spatial pattern recognition, such as track cracks and obstacles. 

• LSTM models temporal progression of anomalies. 

• IoT sensors enrich the system with environmental and mechanical insights. 

These collectively improve accuracy and responsiveness, reducing false positives to below 3%. 

Matrix Visualization 

with TP=1920, TN=2860, FP=75, FN=145) 

 

X.    CASE STUDY SIMULATION 

 

Scenario: 80 km mixed-traffic corridor. 

Test Conditions: Track obstruction, signal failure, unauthorized crossing. 

 

Pre- Interim-Results: 

 

• Detection-to-brake activation: 3.6 seconds  

• Detection confidence: >85% 

• Improvement: 25% faster than baseline model 

 

framework integrates Machine Learning, Deep Learning, IoT sensor fusion, and real-time GPS analytics to establish a 

predictive and preventive railway safety system. The following subsections describe the data-driven approach, model 

design, and system deployment pipe linein detail.  

 

A. Machine Learning Models 

 

Supervised Machine Learning algorithms such as Random Forests, Decision Trees, and Support Vector Machines 

(SVMs) were trained on structured accident datasets to identify the conditions that typically precede accidents. These 

models operate on numerical and categorical features that capture both environmental and operational patterns. 
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Input features include: 

• Speed (real-time vs. safety threshold). 

• GPS coordinates (latitude, longitude). 

• Zone ID and Track ID . 

• Environmental conditions (temperature, visibility, rainfall, fog). 

• Sensor inputs (vibration, signal strength, obstacle detection). 

• Historical accident frequency in the same track segment. 

 

Target outputs are classified as: 

• 0 = Safe condition 

• 1 = Accident risk detected 

 

multi-Class risk classification labels include Signal Failure, Track Obstruction, Over speeding, and Unauthorized 

Access.Feature selection techniques such as recursive elimination wereemployed to reduce computational overhead while 

maintaining prediction accuracy.  

 

B. Deep Learning Techniques  

Deep Learning architectures, particularly Convolutional Neural Networks (CNNs) and Long Short-Term Memory 

(LSTM) networks, were implemented to process visual and sequential data streams. CNNs detect structural defects and 

track obstructions using camera feeds, whileLSTMs learn temporal patterns in sensor and GPS data,improving anomaly 

detection accuracy. The hybrid CNN–LSTM model combines spatial and temporal awareness for improved decision-

making. 
 
C. GPS-Based and IoT Monitoring: 

Real-time GPS data provides continuous tracking of train position, speed, and direction.IoT sensors capture 

environmental and mechanical parameters such as vibration intensity, temperature, and signal strength. Fusing  these 

datasets  allows  the system  to  issue predictive  

alerts before accidents occur.  

Each incoming data vector includes: 

[GPS + Speed + Zone ID + IoT Sensors + Weather] → Feature Vector → Trained Model → Risk Score → Alert 

Trigger 

 

D. Framework: 

The implementation was carried out in Python using TensorFlow and Scikit-learn. The dataset included in it.historical 

accident records from Indian and global sources, enhanced with simulated IoT and GPS data. Each observation was 

tagged with location metadata and timestamp for temporal modeling. A dynamic “AI temperature” scale between 0–

100% represents the model’s confidence in predicting accident probability. Alerts are categorized as Safe (0–30%), 

Caution (31–60%), Warning (61–80%), and Critical (81–100%). 

 

E. Simplified Python Implementation 

 

```python``` 

risk = model. Predict(sensor input)[0][0] 

 

if risk > 0.80: 

    level = "CRITICAL" 

elseif risk > 0.60: 

    level = "WARNING" 

elseif risk > 0.40: 

    level = "CAUTION" 

else: 

    level = "SAFE" 

send_mqtt_alert(level, gps_coordinates) 

```This simplified version continuously monitors sensor and GPS data, evaluates accident risk, and publishes alerts via 

the MQTT protocol to connected operator dashboards in real time. 
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F. Real-Time Alert Flow Diagram 
 

 ┌────────────────────────┐ 

 │ IoT Sensor Inputs      │ 

 │ (Vibration, Temp, GPS) │ 

 └──────────┬─────────────┘ 

            │ 

            ▼ 

 ┌────────────────────────┐ 

 │ Deep Learning Model    │ 

 │ (CNN + LSTM Fusion)    │ 

 └──────────┬─────────────┘ 

            │ 

            ▼ 

 ┌────────────────────────┐ 

 │ Risk Score Computation │ 

 │ Example: 0.86 → High   │ 

 └──────────┬─────────────┘ 

            │ 

            ▼ 

 ┌────────────────────────┐ 

 │ MQTT Alert Publisher   │ 

 │ “CRITICAL ALERT”       │ 

 └──────────┬─────────────┘ 

            │ 

            ▼ 

 ┌────────────────────────┐ 

 │ Operator Dashboard     │ 

 │ Grafana / Mobile App   │ 

 └────────────────────────┘ 

Figure : Real-Time Alert Flow Diagram. 

 

 
Figure : Program Flowchart - Real-Time AI Alert System 
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Below is a complete explanation of every term and block in your Program Flowchart – Real-Time AI-Based Railway 

Alert System,  

  

Flowchart: Real-Time AI-Based Railway Alert System 

 

This flowchart visually represents how your integrated AI–IoT–GPS railway safety system operates in real time — 

from data collection to alert notification. 

 Start 

• The system initialization point. 

• Hardware (IoT modules, GPS receivers, sensors) and software services (Python scripts, AI model loaders, MQTT 

broker) are launched. 

• It sets up data channels and verifies sensor connections before entering the main monitoring loop. 

 

 Read IoT Sensors & GPS 

 

• Collects real-time data streams from: 

o Vibration sensors – detect track vibration frequency anomalies. 

o Temperature sensors – monitor overheating in axles or brakes. 

o Ultrasonic or pressure sensors – detect cracks or pressure variations on tracks. 

o GPS modules – provide train position, direction, and speed. 

• The data is timestamped and sent to the preprocessing module every few milliseconds. 

 

Preprocessing: Normalize, Impute, Augment 

 

This step ensures clean and consistent data for AI models. 

• Normalization: Scales numerical values (speed, vibration amplitude) to standard ranges (0–1). 

• Imputation: - Fills missing values using statistical or KNN-based methods. 

• Augmentation: - Introduces variability (e.g., random noise) to improve model generalization during training. 

 

Feature Extraction: Spatial & Temporal Features 

• Converts raw data into meaningful numerical features: 

o Spatial features → patterns in space (e.g., track image defects using CNN). 

o Temporal features → patterns over time (e.g., recurring vibration peaks using LSTM). 

• Outputs a feature vector, the input for the AI model. 

  CNN: Visual Anomaly Detection 

• The Convolutional Neural Network (CNN) analyzes camera images and video frames. 

• Detects: 

o Track cracks 

o Obstacles 

o Signal malfunctions 

o Unauthorized objects on the track 

• Outputs a probability PCNNP_{CNN}PCNN representing visual anomaly likelihood. 

 

 LSTM: Temporal Sequence Modeling 

 

• The Long Short-Term Memory (LSTM) network processes time-series data from IoT sensors. 

• Learns patterns like: 

o Vibration fluctuation before derailment 

o Temperature rise indicating mechanical stress 

• Produces a probability PLSTMP_{LSTM}PLSTM representing the temporal anomaly confidence. 

  

 Fusion: Combine CNN, LSTM, RF Outputs 

 

• Combines predictions from CNN, LSTM, and Random Forest (RF) to create a final risk score. 

• Weighted fusion formula: 

R=0.4PCNN+0.35PLSTM+0.25PRFR = 0.4P_{CNN} + 0.35P_{LSTM} + 0.25P_{RF}R=0.4PCNN+0.35PLSTM

+0.25PRF  
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• This hybrid fusion improves reliability by combining visual, sequential, and statistical insights. 

 

Compute Risk Score (AI Temperature 0–100%) 

• Converts RRR into a human-readable AI Temperature Scale: 

o 0–30 % → SAFE 

o 31–60 % → CAUTION 

o 61–80 % → WARNING 

o 81–100 % → CRITICAL 

• This risk score is continuously recalculated as new data arrives. 

 

Decision: If R > 0.75 → Critical 

• The system checks the threshold condition: 

o If R>0.75R > 0.75R>0.75: mark as Critical Alert. 

o Otherwise: classify as Safe, Caution, or Warning. 

• This logic ensures real-time response when risk exceeds predefined safety limits. 

 

 MQTT Publish: Send Alert to Control Center 

 

• MQTT (Message Queuing Telemetry Transport) is a lightweight IoT protocol for fast communication. 

• The system sends the alert payload (risk level, GPS, timestamp) to subscribed control centers. 

• Ensures minimal latency, even in low-bandwidth environments. 

 

 Log Event to Database (PostgreSQL) 

• Every alert and sensor snapshot is stored in a centralized PostgreSQL database for: 

o Historical analysis 

o Audit trails 

o Retraining the AI models periodically 

 

Operator Dashboard: Grafana / Mobile View 

 

• The data and alerts are visualized in Grafana dashboards. 

• Operators can: 

o Monitor train locations 

o View current alert level 

 

End / Continue Monitoring Loop  

 

• The system never truly “stops” — it loops back to Read Sensors. 

• Continuous data collection ensures proactive safety monitoring 24×7. 

 

Flow Summary: 

 

Start → Read Sensors → Preprocess → Extract Features → CNN & LSTM Analysis 

→ Fusion → Compute Risk Score → Decision → MQTT Alert → Log → Dashboard → Loop 

This loop forms a self-learning intelligent safety pipeline that can detect risks, alert operators,  

and record incidents autonomously — all in real time. 

 

Experiments were conducted using hybrid edge-cloud architecture with Raspberry Pi 4 devices for edge inference and an 

NVIDIA RTX 3060 Ti GPU for model training. The CNN–LSTM hybrid achieved a 97.8% accuracy and reduced latency 

to under 4 seconds on a 5G network.   

 

Model Accuracy Comparison: 

Random Forest – 94% 

CNN – 96.1% 

LSTM – 95.5% 

CNN + LSTM – 97.8% 
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Network Latency (Average Delay): 

3G: 5.7s | 4G: 3.9s | 5G: 2.8s 

 

Accuracy (%) 

100 |                              █ 

 98 |                     █        █ 

 96 |          █          █        █ 

 94 |   █      █          █        █ 

 92 |   █      █          █        █ 

      -------------------------------- 

        RF     CNN   LSTM   CNN+LSTM 

Latency ↓ 

Avg Delay: 3G (5.7s) → 4G (3.9s) → 5G (2.8s) 

 

H. Conclusion and Final Result   

 

The enhanced framework demonstrates that integrating IoT sensor data with deep neural networks and GPS-based 

tracking significantly improves predictive accuracy and respo-nsiveness in railway accident prevention systems. The 

architecture achieves high precision (97.8%) and low latency (<4s), supporting proactive and real-time decision-making 

for inte lligent railway safety management. 

. 
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